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WHERE ARE THE LESSON FILES?
Purchase of this Classroom in a Book in any format gives you access to the lesson 
files you’ll need to complete the exercises in the book.

1 Go to peachpit.com/AnimateCIB2024.

2 Sign in or create a new account.

3 Click Submit.

●Note If you encounter problems registering your product or accessing the lesson files or web 
edition, go to peachpit.com/support for assistance.

4 Answer the questions as proof of purchase.

5 The lesson files can be accessed through the Registered Products tab on your 
Account page.

6 Click the Access Bonus Content link below the title of your product to proceed to 
the download page. Click the lesson file links to download them to your computer.

●Note If you purchased a digital product directly from peachpit.com, your product will already be 
registered. Look for the Access Bonus Content link on the Registered Products tab in your account.

http://peachpit.com/AnimateCIB2024
http://peachpit.com/support
http://peachpit.com
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52

CREATING GRAPHICS 
AND TEXT

Lesson overview
In this lesson, you’ll learn how to do the following:

• Draw rectangles, ovals, and other shapes.

• Modify the shape, color, and size of drawn objects.

• Understand fill and stroke settings.

• Create and edit curves and variable-width strokes.

• Apply gradients and transparencies.

• Use the different paintbrushes for expressive drawing.

• Create and edit text, and use web fonts.

• Distribute objects on the Stage.

• Create and edit symbols.

• Apply filters to symbol instances.

This lesson will take about 3 hours to complete.

To get the lesson files used in this chapter, download them from the 
web page for this book at peachpit.com/AnimateCIB2024. For more 
information, see “Accessing the lesson files and Web Edition” in 
the Getting Started section at the beginning of this book.

2
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You can use rectangles, ovals, lines, and custom 
brushes to create interesting, complex graphics and 
save them as symbols, which will be displayed in your 
Library panel. Combine gradients, transparencies, text, 
and filters for even greater expressive possibilities.
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Getting started
Start by viewing the finished project to see what you’ll be creating in this lesson.

1 Double-click 02End.gif to view the image.

The project is a simple illustration consisting of an octopus character and a 
humorous caption. In this lesson, you’ll draw the shapes, modify them, and learn 
to combine simple elements to create more complex visuals. You won’t create 
any animation just yet. After all, you must learn to walk before you can run! And 
learning to create and modify graphics is an important step before doing any 
animation with Adobe Animate.

2 In the Animate Home screen, select More Presets or click Create New.

The New Document dialog box opens.

●Note If you 
have not already 
downloaded the project 
files for this lesson to 
your computer from 
your Account page, 
make sure to do so now. 
See Getting Started at 
the beginning of the 
book.
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3 Choose Advanced from the top row of categories. In the Platforms section, 
choose HTML5 Canvas. In the Details section, make the Stage size 1200 pixels 
by 800 pixels, and click Create.

4 Choose File > Save. Name the file 02_workingcopy.fla, and save it in the 02Start 
folder.

Saving your file right away is a good work habit (even if you’ve enabled the Auto-
Recovery feature). It ensures that you won’t lose your work if the application or 
your computer crashes.

Understanding strokes and fills
Every graphic created within Animate starts with a shape. A shape consists of two 
components: the fill, or the inside of the shape, and the stroke, or the outlines of the 
shape. If you always keep these two components in mind, you’ll be well on your way 
to creating beautiful and complicated visuals.

The fill and the stroke function independently of each other, so you can modify or 
delete one without affecting the other. For example, you can create a rectangle with 
a blue fill and a red stroke and then later change the fill to purple and delete the red 
stroke entirely; you’ll be left with a purple rectangle without an outline. You can also 
move the fill or stroke independently, so if you want to move the entire shape, make 
sure you select both its fill and its stroke.
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Creating shapes
Animate includes several drawing tools, which work in different drawing modes. 
Many of your creations will begin with simple shapes such as rectangles and ovals, 
so it’s important that you’re comfortable drawing them, modifying their appearance, 
and applying fills and strokes.

You’ll begin by drawing the face of the octopus.

Using the Oval tool
The eyes of the octopus are essentially a series of ovals overlapping one another. To 
make the eyes look angry, there is a diagonal line that cuts the largest oval at a slant. 
You’ll start by drawing the ovals. It’s useful to break down complicated objects into 
their component parts to make it easier to draw them.

1 Rename Layer_1 octopus.

2 In the Tools panel, select the Oval tool, which is hidden under the Rectangle 
tool. Hold down the Rectangle tool to access the Oval tool underneath. Make 
sure the Object Drawing button at the bottom of the Tools panel or in the 
Properties panel is not selected.

●Note In Animate, 
as well as in HTML 
documents and in 
web design and 
development in 
general, colors are 
often specified by 
hexadecimal numbers. 
The six digits after the 
# sign represent the 
red, green, and blue 
contributions to the 
color.
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3 Choose a stroke color and a fill color from the bottom of the Tools panel or 
from the Properties panel. Enter #CCCCCC (light gray) for the fill and #000000
(black) for the stroke.

4 On the Stage, draw an oval that is a little taller than it is wide.

5 Select the Selection tool.

6 Drag the Selection tool around the entire oval to select its stroke and its fill. When 
a shape is selected, Animate displays it with white dots. You can also double-click 
a shape, and Animate will select both the stroke and fill of the shape.

7 In the Properties panel, in the Position And Size section, enter 40 for the Width 
and 55 for the Height. Press Return (macOS) or Enter (Windows) to apply the values.
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Adding the inside of the eye
Now you’ll create the inside of the eye and the white highlight.

1 In the Tools panel, select the Oval tool.

2 Choose a stroke color and a fill color from the bottom of the Tools panel. Enter 
#000000 (black) for the fill and #000000 (black) for the stroke.

3 Draw a smaller black oval inside the larger oval on the Stage.

4 Enter #FFFFFF (white) as the fill for your Oval tool.

5 Draw a third oval at the top of your black oval, which will be the highlight.

Animate drawing modes
Animate provides three drawing modes that determine how objects interact 
with one another on the Stage and how you can edit them. By default, Animate 
uses Merge Drawing mode, but you can enable Object Drawing mode or use the 
Rectangle Primitive or Oval Primitive tool to use Primitive Drawing mode.

Merge Drawing mode

In this mode, Animate merges drawn shapes, such as rectangles and ovals, where 
they overlap so that multiple shapes appear to be a single shape. If you move or 
delete a shape that has been merged with another shape, the overlapping portion 
is permanently removed.

●Note The last fill 
and stroke you used 
are applied to the next 
objects you create, 
unless you change the 
settings before you 
draw.

▶ Tip Hold down 
the Shift key as you 
draw to constrain your 
shapes. Holding the 
Shift key when using 
the Oval tool creates 
perfect circles, much 
like holding the Shift 
key when using the 
Rectangle tool creates 
perfect squares.
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Object Drawing mode

In this mode, Animate does not merge drawn objects; they remain distinct and 
separate, even when they overlap. To enable Object Drawing mode, select the draw-
ing tool you want to use, and then click the Object Drawing button at the bottom of 
the Tools panel.

To convert an object to a shape (Merge Drawing mode), select the object and 
choose Modify > Break Apart (Command+B/Ctrl+B). To convert a shape to an object 
(Object Drawing mode), select the shape and choose Modify > Combine Objects 
> Union. The current shape becomes an object, but keep in mind that it doesn’t 
restore the shape to how it was originally drawn.

Primitive Drawing mode

When you use the Rectangle Primitive tool or the Oval Primitive tool, Animate 
draws your rectangles or ovals as independent objects that maintain some editable 
features. Unlike with regular objects, you can modify the corner radius and the start 
and end angles of rectangle primitives as well as adjust the inner radius of oval 
primitives using the Properties panel.

Making selections
To modify an object, you must first be able to select different parts of it. In 
Animate, you can make selections using the Selection, Subselection, and Lasso 
tools. Typically, you use the Selection tool to select an entire object or a section of 
an object. The Subselection tool lets you select a specific point or line in an object. 
With the Lasso tool, you can make a free-form selection.
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Selecting strokes and fills
Now you’ll refine the ovals to look more like an eye. You’ll use the Selection tool to 
delete unwanted strokes and fills.

1 In the Tools panel, select the Selection tool.

2 Double-click the stroke around the white oval.

The strokes around both the white oval and the black oval become selected.

3 Press the Delete/Backspace key.

The strokes are deleted, leaving behind a white oval as the highlight.

4 Choose the Line tool, and enter #000000 (black) as the stroke color.

5 Draw a diagonal line that cuts through the top of the eyeball.

The straight line creates intersecting shapes in the eyeball so that they can be 
selected separately.

6 Choose the Selection tool and click the half-dome gray shape at the tip of the eye.

7 Press the Delete/Backspace key.
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The gray fill is deleted.

8 Choose the curved stroke above the straight line and delete it.

One eye is finished!

Editing shapes
When drawing in Animate, you’ll often start with simple shapes such as rectangles, 
ovals, and lines. But to create more complex graphics, you’ll use other tools to 
modify those base shapes. The Free Transform tool, the Copy and Paste commands, 
and the Selection tool can help speed up your workflow.

Using Copy and Paste
Use the Copy and Paste commands to easily duplicate shapes on the Stage. Your 
octopus needs two eyes, so copying and pasting will come in handy.

1 Select the Selection tool, and drag it around the entire drawing of your eye.

2 Choose Edit > Copy (Command+C/Ctrl+C).

The eye is copied.

3 Choose Edit > Paste (Command+V/Ctrl+V).

A duplicate eye appears on the Stage. The duplicate remains selected.

4 Move the duplicate eye close to your original eye.

▶ Tip Use 
Paste In Place 
(Shift+Command+V/
Shift+Ctrl+V) if you 
want to paste the 
copied graphic in the 
exact same place where 
you copied it from.
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Using Free Transform
The duplicate eye needs to be flipped to make it look right. You’ll use the Free 
Transform tool to make it a mirror image of itself. You can also use the Free 
Transform tool to change an object’s scale, rotation, or skew (the way it is slanted), 
or to distort an object by dragging control points around a bounding box.

1 Choose Modify > Transform > Flip Horizontal.

The object flips, and you now have a right eye and a left eye.

2 Choose the Free Transform tool from the Tools panel.

Transformation handles appear on the eye.

3 Drag a corner point inward to make the left eye a little smaller. Hold down the 
Shift key while dragging to constrain the proportions so that the eye maintains 
the same aspect ratio.

4 Have fun making the second eye a little crazy. You can drag the corner points to 
squash or stretch an object or to rotate the object. You can also drag the sides of 
the bounding box to skew the object so that it appears slanted.

▶ Tip If you press 
the Option or Alt key 
while moving one of 
the control points, 
Animate scales the 
selected object relative 
to its transformation 
point, represented 
by the circle icon. 
You can move the 
transformation point 
anywhere, even outside 
the object. Press Shift 
to constrain the object 
proportions. Hold the 
Command/Ctrl key to 
distort the object from a 
single control point.

▶ Tip Hold the 
Command/Ctrl key to 
drag a single control 
point to distort the 
eyeball. If you press and 
hold Shift+Command/
Shift+Ctrl as you drag 
a corner point, you can 
move both corners 
the same distance 
simultaneously.
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Changing shape contours
With the Selection tool, you can push and pull lines and corners to change the over-
all contours of any shape. It’s a fast and intuitive way of working with shapes. You’ll 
use this technique to create the organic shape of the octopus head and body.

1 Insert a new layer on the timeline and name it body. Drag it so that it is below 
the octopus layer, which currently contains the eyes.

2 In the Tools panel, select the Oval tool. Choose a green color for the fill 
(#33CCCC) and black for the stroke.

3 Create three overlapping ovals, similar to the following figure, off to the side of 
the eyes. You don’t have to be exact here since you’ll edit these shapes.

4 Select the black outlines and press the Delete key.
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The black strokes are deleted.

5 Move your mouse cursor close to the side of one of the ovals.

A curved line appears near your cursor, indicating that you can change the 
curvature of the stroke.

6 Drag the stroke outward.

The side of the oval bends, giving the octopus head a slight bulge. Push and pull 
on the contours of the three ovals to create a more organic, bulbous head and 
natural-looking brow ridge for your octopus.

If you want to create a new corner point so that you can change the directions of 
a curve, hold down the Option/Alt key while you drag on the curve.
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Changing strokes and fills
If you want to change the properties of any stroke or fill, you can use the Ink Bottle 
tool or the Paint Bucket tool. The Ink Bottle tool changes stroke colors; the Paint 
Bucket tool changes fill colors. The check mark next to the quick key indicates the 
currently selected tool that is displayed in the Tool panel.

• Select the Paint Bucket tool and choose a new fill color in the Properties panel. 
Click a fill to change its color.

• Select the Ink Bottle tool (hidden under the Paint Bucket tool) and choose a new 
stroke color in the Properties panel. You can also choose the thickness and style 
of the stroke. Click a stroke to change its properties.

• You can also simply select a stroke or a fill on the Stage and change its properties 
by using the Properties panel.

Using variable-width strokes
You can make many different styles of lines for your strokes. In addition to the basic 
solid line, you can choose a dotted, dashed, or ragged line, or even customize your 
own. You can also create lines with variable widths and edit the variations with the 
Width tool.

Adding thick and thin outlines
The variable width of strokes can help give your drawings more expressive character.

1 Select the Ink Bottle tool, and in the Properties panel, choose 6 for the Stroke 
Size and Width Profile 1 for the Width.

▶ Tip If your Paint 
Bucket tool changes the 
fill in surrounding areas, 
there may be a small 
gap in the shape outline 
that allows the fill to 
spill over. Close the gap 
manually, or use the 
Gap Size menu at the 
bottom of the Tools 
panel to choose the gap 
size that Animate will 
close automatically.
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2 Click the large green octopus head.

Animate applies the thick-thin width profile to the outline of your green fill.

3 With the Selection tool, choose a single stroke segment around the green head, 
and then change the Stroke Size to 4.

Now you have two different stroke widths around your shape.

Stroke size of 4

Stroke size of 6
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4 Delete the stroke around the bottom oval shape. You’ll connect the octopus 
tentacles there, so you won’t need the black outline.

Refining variable-width lines
In addition to applying different width profiles to a stroke, you can customize where 
the bulges appear and how wide the bulges are with the Width tool.

1 Hold down the Shift key and click the three line segments of one of the eyebrows.

2 In the Properties panel, change the Stroke Size to 10.

3 Change the Width to Width Profile 1.

The straight line turns into a thicker line that is skinny on the ends and fatter in 
the middle, giving it a little more personality.

▶ Tip Edit variable-
width lines as you 
would any other stroke. 
Use the Selection or 
Subselection tool to 
bend the curves or 
move the anchor points.
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4 Click the three dots at the bottom of the Tools panel to edit the Toolbar.

5 Drag the Width tool from the Drag And Drop Tools panel to your Tools panel so 
that you can use it. Click off the Tools panel or press the Esc key to collapse it.

6 Move your mouse pointer over one of your variable-width strokes.

Anchor points appear along the line to show you where the thick and thin 
portions of the line are located.

▶ Tip To delete an 
anchor point of a 
variable-width line, click 
to select the anchor 
point and press Delete/
Backspace.
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7 Drag the handles at any anchor point to change the width of the line. Exaggerate 
some of the restrictions and bulges.

8 Drag an anchor point along the stroke to move its location.

9 Drag anywhere along the stroke to add a new anchor point and define the width 
at that location. Animate displays a small plus (+) sign next to your pointer to 
indicate that you can add an anchor point.

10 Modify both eyebrows of your octopus as you see fit, and apply a different width 
profile to the outline around the eyes as well.

Organizing your drawing
Now that you’ve finished creating the eyes and the head, you’ll want to start organiz-
ing the different parts of the drawing. You’ve already organized different shapes by 
putting them in separate layers, but you can also use groups to keep them separated.

Grouping objects
A group holds together a collection of shapes and other graphics to preserve their 
integrity. When the elements that compose the eyes are grouped, you can move 
them as a unit without worrying that the eyes might merge and intersect with 
underlying shapes in the same layer.

▶ Tip Hold down 
Option/Alt when you 
want to modify only 
one side of a variable-
width line.
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NUMBERS
3D Rotation

Local mode, 160
motion tweens and, 276
programs supporting, 11
titles added via, 159
z-depth and, 323

3D titles, 159
3D Translation, 11, 158–159, 323

A
Access Bonus Content, iii
Actions panel, 435–444, 453
ActionScript 3.0

Actions panel, 436–437, 453
Actions panel wizard,  

437–440
debugging, 444
mask transparency in, 348
naming for, 430
numbering frames, 444
timeline control with, 156
use of, 12, 420

Adobe, 6
Adobe Animate Classroom in a 

Book (Chun)
additional resources, 5–6
Animate installation, 2–3
author information, 7
lesson files, 4
use of, 1–2

Adobe Extensions, 6
Adobe Fonts, 103, 105–106
Adobe Media Encoder, 161, 162, 

328–329
ads, banner, 419
AIR for Android, 12, 48, 420
AIR for Desktop, 12, 420
AIR for iOS, 12, 420
Align panel, 109–110, 111
aligning objects, 109–110
alpha values, 99, 348
ANA file, 113, 114, 115

anchor points
adding/deleting, 79, 287
bone-in-shape, 397
curves and, 79
direction handles, 287
for eases, 139
moving, 286
property curve, 284–287
width variety with, 67, 68

angles
direction handle, 287
rotation, 214–216

Angular blend, 340
Animate

compatible applications, 14
default interface, 17
document types, 11–14
drawing modes, 58–59
file opening, 10–11
installation of, 2–3
layer effects, 42–44
Library panel, 19–21
modifying content/Stage, 48–50
new features, 2
overview of, 8–51
panels, 36–37
previewing/exporting, 46–48
Properties panel, 33–37
saving movies, 50
Stage, 18–19
Timeline panel, 21–29
Tools panel, 38–41
undoing steps, 45
workspace, 14–17

animation
button, 454–457
camera movements, 302, 

308–310
character. See character 

animation
color, 359, 363
defined, 121
duration changes, 131–133

exporting movies, 161–162
of filters, 140–143
Flexi bone, 258–263
gradient fills, 360–363
graphic symbol, 185
inverse kinematics, 371, 373
looping, 155, 156, 382
mask, 352–356
modern rigging, 221–227, 

244–246
motion tweens, 276–279, 

281–282, 283
of multiple properties, 130–131
nested, 152–156, 400–401
onion skinning previews, 

356–359
pacing/timing changes, 

130–135
played at destination, 449–453
position, 121, 124–127
previewing, 127–128
project file, 120–121
review of, 163
of scale, 128–130
shape, 335, 392–397
speed, 131–133
3D titles, 159
transition animations, 449–451
transparency, 135–137
warp options, 239
z-depth, 323

Animator workspace, 16
Apple Silicon M1/M2, 2
armature

adding poses, 388–392
applied to new graphics, 

409–414
bones in shapes, 393–395
building an, 374–377
controlling shapes via, 397
disabling/constraining joints, 

385–388
extending, 377–378

INDEX
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hierarchy, 379
joint positioning, 380–381
looping cycle for, 382–385
moving bones in, 379–380
rearranging stacking order, 

381–382
review of, 415
saving, 406
spring for, 397
use of, 374

Art brush, 84–86
Asset Warp tool

animating rig with, 201, 245
Bone tool vs., 373
branching rigs with, 233
envelop deformer option, 

25, 263
Flexi bone animation, 254, 

258–263
how to use, 204–216
for mask animation, 353
Propagate option, 224
shape twining vs., 335

assets
collaboration on, 113–115
exporting/importing, 114–115
importing Photoshop, 

122–124
symbols, 87–89
See also Assets panel

Assets panel
collaborating via, 113–115
resources on, 6, 376
saving armatures in, 406
saving assets in, 20

Auto Keyframe mode, 27–28, 125
Auto-Recovery, 50

B
backgrounds

animating colorful, 124–127
locking, 128

backups, 50
banner ads

button creation for, 420–422
click code, 441–444

destination keyframes, 
431–435

new documents for, 419
“Shop now” button, 445–448
timeline for, 431

Basic workspace, 16
beginner users, 14, 16
beginning keyframes, 173–175
Bezier curves

Bezier handles, 282
for eases, 139
Flexi bone tool, 244, 254, 257
property curves, 283

Bind tool, 397
Bitmap Properties, 36
bitmaps

rigs inside, 204
single, 112
swapping, 426–427
unnatural stretching of, 214
vectors converted to, 232, 

255–256
Warped Bitmap, 207

Blend types, 340
Blur filter

animating, 140–143
applying, 102
layer effects with, 42–44

blurs, 140, 141
Bone tool

adding poses, 388–392
adding/removing bones, 380
armature hierarchy, 379
Asset Warp vs., 373
building an armature, 

374–377
disabling/constraining joints, 

385–388
extending the armature, 

377–378
inverse kinematics with 

shapes, 392–397
joint positioning, 380–381
looping cycle, 382–385
moving armature bones, 

379–380

project file, 372
review of, 415
springiness, 397–400
stacking order, 381–382
tweezing automatic rotations, 

400–406
Bone Type, 206, 242
bones

adding/removing, 248–250, 380
creating, 204–212
defined, 374
fixing individual, 384–385
Flexi, 243–244, 254–263
hard, 238–240, 243–244
inside shapes, 393–395
isolating rotation of, 383–384
joints unconnected to, 250
movie clips belonging to, 411
moving armature, 379–380
parent/child, 379
placing, 376
positioning, 218–219
reconnecting, 221
removing, 220–221
soft, 240–244, 243–244
on-Stage controls, 389

Bones and Motion saves, 409
Bounce eases, 184
Bounce In ease, 296
bounces, 289
branching rig, 232–237
broken, 346
broken tweens, 346
brush modes, 81–86
brushes, 71–74
button symbols

animated, 454–457
creating, 420–422, 445–448
defined, 87
duplicating, 425–426
editing, 422–424
invisible, 425
navigation via, 417, 420
placing, 427–429
use of, 88
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C
calligraphic brushes, 84
Camera tool

animating camera moves, 302, 
308–313

attaching layers to, 323–324
characteristics of, 306
creating depth, 317
easing and motion options, 316
enabling, 305–306
following via, 302
frame setting, 306–308
panning animation, 311–312
project file, 302–305
review of, 330–331
rotation animation, 313
zoom-in animation, 302, 

312–313
zoom-out animation, 308–310

captions, 325–327
character animation

inverse kinematics for, 371, 373
layer parenting for, 165, 

167–170
lip-syncing dialogue, 185–197
modern rigging for, 204
program files, 166
tweening in connected layers, 

173–183
child bones

armature hierarchy, 379, 415
inverse kinematics for, 373
joint isolation and, 246–248
pinning parents, 385

child joints
bone display and, 243
branching rig, 232–237
joint isolation and, 247
relational hierarchy for, 214
single parent format for, 234

child layers
color/filter as uninherited  

by, 178
defined, 167
deselecting propagation for, 178
layer reordering and, 171

parent tweening and, 179–180
relational hierarchy for, 170, 

171, 198–199
single parent format for, 170

Chun, Russell, 7
Classic Brush, 71, 84, 94
Classic Ease, 138, 183
classic tweens

advanced easing for, 184
animation via, 121, 355–356
applying, 175–176
automatic rotation via, 

400–406
begin/end keyframes for, 

173–175
changing pace via, 131
creating, 126
eases for, 139, 183
Flexi bone animation  

with, 262
motion guides for, 144–145
motion tweens and, 276
for nested animations, 155
parent layer, 179–180
recalculation of, 248
removing, 127
review of, 163
rig animation with, 201, 

223–224
rules of, 121

clicks, button, 441–444
closed paths, 80
code

Actions panel entry of, 
436–437

Actions panel wizard, 
437–440

debugging, 444
mouse click, 441
names for, 430
pinning, 453
replicating, 444
“Shop now” button, 445–448
stopping timelines with, 429

Code Snippets panel, 448
collaboration

Assets panel for, 113–115
tweening and, 121

color
animating, 135, 359, 363
applying effects, 101
Camera effects, 327–328
code hinting, 444
gradient transitions, 96–98
inheritance and, 178
layer effects, 42–44
numbers representing, 56
rig animation, 223
of shadows, 142
Stage, 18

Color panel, 96
color pointer, 96
Command/Ctrl key, 62
complex eases, 139, 289–298
constraining joints, 385–388
content modifications, 48–50
contours, changing, 63–64
control points

Bind tool, 397
envelope deformation via, 265
Free Transform tool, 62
subtle movement of, 268

conversions, document type, 12
Convert Layers to Symbols, 156, 

407
Convert to Bitmap, 112
Copy command, 61
Copy layers, 32
Create, 6
Create Bones, 207
Create Classic Tween, 126, 130
Creative Cloud

Adobe Media Encoder, 
328–329

Animate as part of, 2
storing assets in, 20
tutorials, 6
user interface, 3

creative.adobe.com, 3
curves

bending motion paths, 
281–282

http://creative.adobe.com
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Bezier, 139, 254, 257, 283
customized ease, 183
drawing, 75–79
ease profiles, 139, 184
editing shape hint, 344
Flexi bones, 262
property, 287, 298
property vs. ease, 298
rendering speed of, 112
rigging, 204, 244

Cut layers, 32

D
damping, 399–400
debugging, 444
decoration, 39
deleting

strokes/fills, 60
timeline layers, 25

density, mesh, 217
depth

creating, 317
setting z-depth, 320–322
shadow effects, 224–227
transparency and, 99–100

Designer workspace, 16
destination keyframes, 431–435
dialogue, lip-syncing, 185–197
direction handles, 287
disabling joints, 385–388
distributing objects, 109–110
Distributive blend, 340
docks, 36, 37
document types, 11–14
drawing modes, 58–59
drop shadow effect, 140, 141, 143, 

224–227
Duplicate layers, 32
dynamic text, 103–105

E
ease-in/ease-out

defined, 138–139
Easing values, 299
realism via, 252
shape tween, 346–347
simple and complex, 183

starts/stops via, 391
varying intensities for, 184

eases/easing
advanced, 183, 347
to animate filters, 141
Camera tool, 316
classic tween application, 183
complex, for motion tweens, 

289–298
curves, 298
customizing, 139, 347
defined, 121
inverse kinematic, 391
Motion Editor for, 283, 

293–296
presets, 297
shape tweens, 346–347

Easing value, 299
Edit Multiple Frames, 156
educators, resources for, 6
Elastic eases, 184
Enable menu, 20
ending keyframes, 173–175
envelopes

deformations of, 263–269, 335
flexible bending of, 240–244
Handle modes, 253
mesh options, 217
modern rigging, 204

errors, code, 444
Essentials workspace, 15, 21, 36
events, 441
expert users, 14
exports

Animate, 46–48
animated GIF, 367–368
graphics, 111–112
movie, 161–162, 328–329
of workspace preferences, 17
See also published videos

F
fade-in effects, 137–139
features, supported, 11
files

opening Animate, 10–11

optimization by format 
option, 112

fills
alpha values of, 99
brushes, 71
changing, 65
default setting, 58
defined, 55
masks and, 348, 349
selecting, 60–61
shape tweening, 360–365

filmstrips, 21
filters

adding multiple, 143
animating, 140–143
applied in HTML5, 140
Blur filter, 102
enabling/disabling, 143
shadow effects, 224–227
visibility of, 143

Filters section, 141–142
Fixed Handle mode, 253
FLA file, 419
Flexi bones

adding rigs with, 254–258
defined, 243–244
how to use, 254

flexibility, 240–244
flip changes, 178
Fluid Brush, 71, 71–73, 82,  

94, 117
folders

adding layers to, 30–31
creating layer, 29–30

fonts
adding web, 105–108
availability of, 105
removing web, 108

foreground, unlocking, 128
forums, Adobe, 6
forward kinematics, 373
Frame Picker, 2, 186–193
frame rate, 133
frames

animated GIF exports, 112
Auto Keyframe mode, 27–28
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editing multiple, 156–158
frame-based selection, 

279–280
inserting, 25–26
keyframe creation, 26
labeling/numbering, 444
moving keyframes, 28–29
removing keyframes, 29
review of, 51
selecting motion tween, 286
selecting multiple, 26
size adjustments for, 193
tween recalculation, 248
See also keyframes

Free Transform tool
animating transformations 

with, 150
motion tween use, 291
object rotation with, 194
orienting objects with, 150
shape editing with, 61, 62
size/position/overlap edits, 91
swapping instances with,  

180, 181
symbol instance use, 91

freezing joints, 238–240
full-screen mode, 18

G
gaps, closing, 65
Georgenes, Chris, 166
GIF exports, 111–112, 367–368
Global Transform, 159, 160
global transformations, 159, 160
Google Fonts, 103
gradient fills, 96–99, 360–363
Gradient Transform tool

adjusting gradient fills, 362, 
366

animating gradient fill, 360
how to use, 98–99

graphic symbols
defined, 87
lip-syncing dialogue with, 

185–197
looping animation with, 185
use of, 89

graphics
aligning/distributing objects, 

109–110
applying armatures to, 

409–414
brush modes, 71–74, 81–86
camera layers for fixed, 

323–324
curves, 75–79
editing shapes, 61–65
gradient fills, 96–99
grouping, 69–71
importing, 20
lesson on, 52–117
rendering speed, 112
review of, 116–117
rigs inside, 201, 204
selections, 59–61
shape creation, 56–59
stacking order of, 381–382
strokes and fills, 55
symbols, 87–89
text, 103–109
Tools panel additions of, 

39–41
variable-width strokes, 65–69
warped assets, 227–228

groups
how to form, 37
object, 69–71
panel, 36–37
warped asset, 227–228

guides, 111
guides, motion, 144–148, 151

H
H.264-formatted video, 162
Handle modes, 253
hard bones, 238–240, 243–244
head motion, 193–195
Height, 49
hierarchy, armature, 379
high mesh density, 217
highlighting layers, 31–32
hints, shape, 340–345
History panel, 45
Hit keyframe, 425

Home screen, 12–13
Hosted Libraries, 429
hotspots, 425
HTML Canvas, 112
HTML files, 418
HTML5 browsers, 11
HTML5 Canvas

3D rotation in, 161
Actions panel, 436–437
applying filters in, 140
JavaScript on, 420
new documents, 419
supported features, 11
text on, 103
use of, 12

I
image smoothing, 36
imports

from compatible applications, 
14

of Photoshop assets, 122–124
to Stage, 21

instances, symbol
applying filters to, 143
button, 426–427
classic tweening with, 121
color effects of, 101
defined, 88
effects for, 130, 135
layer parenting for, 168, 178
managing, 90–96
movement inheritance for, 178
naming, 430
swapping, 180–183
tweening in connected layers, 

173–183
See also symbols

interactive navigation
Actions panel, 435–444
buttons and code for, 417
Code Snippets panel, 448
creating/editing buttons, 

420–424
destination keyframes, 

431–435
Hit keyframe, 425
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interactive movies, 419
JavaScript interactivity, 

437–444
naming tips, 430
playing animation, 449–453
review of, 458
“Shop now” button, 445–448
timeline, 431

internet connection, 429
inverse kinematics

animation via, 371
defined, 373
shapes with, 392–397
See also Bone tool

invisible buttons, 425
isolating bone rotation, 383–384
isolating joints, 246–248, 259

J
JavaScript

Actions panel, 435–444
Actions panel wizard, 437–444
ActionScript vs., 420
interactivity, 420, 437–444
learning code, 444
looping animation and, 156
naming for, 430
numbering frames, 444
stopping timelines with, 429
use of, 11

joints
creating, 208
defined, 374
disabling/constraining, 377, 

385–388
freezing, 238–240
Handle modes, 253
isolating, 246–248, 259
joint speed changes, 391
parent/child, 214, 232, 232–

237, 243, 247, 379
positioning, 218–219, 380–381
reconnecting, 221
removing, 220–221
rigs with branching, 232–237
single, 250–253

JPEG exports, 111–112

K
keyframer.com, 166
keyframes

adding layer effects, 42–44
applying filters to, 143
begin/end for classic tweens, 

173–175
connected layers via, 171
destination, 431–435
editing multiple, 156–158
Hit and Up, 425
inserting new, 125
labels on, 435, 444
lip-syncing dialogue, 186, 188
motion tween, 286, 287
moving, 131, 280–281
pacing changes, 345–346
poses as, 388
propagation across, 250
property, 288–289
review of, 51
rig animation, 221–223, 

244–246
shape hints in, 342, 345
shapes in, 335, 337–338
tweening between, 121
value changes between, 140
working with, 25–29

L
labeling keyframes, 435, 444
Lasso tool, 59, 117
Layer Depth panel, 317, 320–322
layer parenting

animation hierarchies via, 165
connecting parts in, 167–170
editing, 171
layer stacking changes, 171–173
review of, 198–199
symbol instances, 178

layers
adding effects, 42–44, 51
adding layers, 24
attached to Camera layer, 

323–324
camera depth and, 317, 317–320

cut/copy/paste/duplicate, 32
deleting/rearranging, 25
function of, 22
guide layers, 405
highlighting, 31–32
importing Photoshop, 

122–124
locking, 111, 128
mask, 347–349
parent/child, 167, 169
renaming, 23
stacking edits, 171–173
timeline organization of, 

29–32
transparency controls, 24
tweening in connected, 173–183

lesson files
downloading, 4
how to use, 5
locating, iii

Library panel
bitmap storage in, 124
editing symbols from, 93
how to use, 19–21

linear gradients, 96, 363, 365, 366
linear graphics, 96
lines, variable-width, 65–69
Lip Syncing tool, 186
lip-syncing dialogue, 185–197
local transformations, 159, 160
locking layers, 111
looping

armatures for animated, 
382–385

graphic symbols, 185
of nested animations, 155
preventing, 156

low mesh density, 217

M
macOS installation, 3
magnification, 288
mapping rigs, 406–414
markers, adjusting, 358
masks

animating, 352–356
creating and using, 347–352

http://keyframer.com


466 Index

effects of, 350–351
function of, 333

Media Encoder, 47
Merge Drawing mode, 58, 117
mesh envelope. See envelopes
modern rigging

adding to, 210–212
animation of, 221–227
Asset Warp for, 204–216
branching joints on, 232–237
defined, 204
editing warped assets, 

228–232
envelope deformations, 

263–269
Flexi bones, 254–263, 269
hard, soft, and Flexi bones for, 

243–244
mesh options, 217
moving a rig, 212–214
organizing warped assets, 

227–228
project file, 202–204
propagating rig edits, 248–250
review of, 270–271
rig creation, 204–209
rig editing, 218–221
rotation angles, 214–216
single joints, 250–253
warp options, 239

motion
editing multiple frames of, 156
inverse kinematics for, 371
lip-syncing dialogue, 185–197
modern rigging for, 212–214
motion guides, 316
realistic, via easing, 138
shadow effects, 224–227

Motion Editor
applying eases from, 293–296
availability of, 283
Camera tool and, 316
deleting anchor points, 287
differing eases for, 298
function of, 273
magnification changes, 288

property curves, 283–287
shape tweens and, 346
viewing options, 288

motion guides, 144, 151
motion tweens

adding eases to, 138
animation via, 276–279
for automatic rotations, 

400–401
classic tweens vs., 276
complex ease additions, 

289–298
connected layers with, 173–183
editing motion paths, 281–282
function of, 276
keyframe insertion, 286
Motion Editor, 283–287
moving anchor points in, 286
project file, 274–275
property keyframes, 288–289
removing, 127
review of, 299
spans, 279–281
3D animation with, 159
transition animations, 449–451
tween span timing, 280–281

mouse hover, 454
mouth position, 186
MOV files, 329
Move Guide dialog, 111
movie clip symbols

animated, 454–457
animating rotation in, 400
defined, 87, 88
graphic symbols and, 185
nested animations, 152–156
saving armatures as, 406

movie clips
adding/removing, 380
creating MP4s, 162
interactive, 419
stacking order, 381–382
stopping, 451–453, 457

movies
exporting final, 161–162
saving, 50

MP4 movie files, 161, 328–329
multiplane camera, 317
multiple frame editing, 156–158

N
naming

armature, 376
button instances, 430
layers, 23
rules for, 430
warped assets, 227–228

nested animations, 152–156
new documents, 12–14, 419
No Ease, 139
nonlinear navigation, 420

O
Object Drawing mode, 59, 117
objects

aligning/distributing, 109–110
animating, 121
converted to symbols, 89–90
creating paths for moving, 

144–148
distortion, 62
easing, 138
editing, 61–65
grouping, 69–71
movement inheritance for, 178
orienting to paths, 148–152
overlapping of, 171, 378
parent/child parts in, 167
positioning, 34–35, 109–111

onion skinning, 356–359
on-Stage controls, 389
Open Handle mode, 253
open paths, 80
optimization, 112
organization

layers in a timeline, 29–32
Library panel, 19
Timeline panel, 22

Orient to Path, 148
outlines, variable-width, 65–69
Oval tool, 56–57
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P
pacing changes, 130–135, 345–346
Paint Brush, 71, 83–86
paint brush modes, 81–86
Paint Bucket tool, 65
Paint Fills Only, 81–82
panels, 36–37
panning, camera, 311–312
parallax effect, 317, 320, 322
parent bones

armature hierarchy, 379, 415
inverse kinematics for, 373

parent joints, 214, 243, 247
parent layers, 167, 179–180
Parenting View, 167–170, 171
Paste command, 61
Paste in Place tool, 61
Paste layers, 32
pasteboard, 18
paths

bending motion, 281–282
Camera tool, 316
creating motion, 144–148
editing motion, 281–282
orienting objects to, 148–152
Pen tool, 80

Pattern brush, 85–86
peachpit.com, iii, 4
Pen tool

creating paths with, 80
curves with, 75–78
deleting anchor points with, 79
to edit motion paths, 148

Pencil tool, 146
performance, 2, 111, 112
phonemes, 186
photographic masking, 352
Photoshop, 122–124
physics, simulating

Bounce and Elastic eases for, 184
complex eases for, 185
springiness for, 397–400

pinning code, 453
placing buttons, 427–429
playback controls

for graphic symbols, 185

for nested animations, 156
nonlinear navigation, 420
Timeline panel, 21, 127–128

playback environment, 11
PNG exports, 111–112
PolyStar tool, 39–41
poses, adding, 388–392
positioning

aids, 18
animating position, 121, 

124–127
armature, 382–383
armature joint, 380–381
lip-syncing dialogue, 186
objects, 34–36, 109–111
rig animation, 223
rigging joints/bones, 218–221
rulers and guides for, 111

preferences, workspace, 17
prerequisites, 2
previews

animation, 127–128
exports and, 46–48, 161
internet connection for, 429
onion skinning for, 356–359

Primitive Drawing mode, 59, 117
product registration, iii, 4
programming scripts, 420
projectors, 12
Propagate option, 224
propagating rig edits, 248–250
Properties panel

in Essentials workspace, 15
how to use, 33–37
tools in, 38

property curves
anchor points, 299
applying eases to, 296–298
deleting, 299
direction handles, 299
ease curves vs., 298
editing, 299
examining, 283–284
keyframes, 285–286

property keyframes, 288–289
Publish, 46–48, 161, 197

published videos
ActionScript and JavaScript, 

420
animated GIF, 367–368
document types for, 12
file format options, 111–112
guides as invisible in, 111, 405
HTML Canvas exports, 112
online, 429
playback technology, 11
using Quick Share and 

Publish, 46–48, 161, 197
See also exports

puppet pins, 2

Q
Quick Share, 46–48, 161, 197
Quick Share And Publish, 111

R
radial gradients, 96, 360–363
registration, product, iii, 4
renaming layers, 23
rendering speed, 112
resizing via Stage, 48–50
resources, additional, 5, 6
rig mapping, 406–414
rigs, 201
root bone, 377, 411
root joints, 236
rotation

angles, 214–216
animating, 143–144
Camera tool for, 313
disabling/constraining joint, 

385–388
isolating bone, 383–384
rig animation, 223
on-Stage controls, 389
tweening automatic, 400–406
See also 3D Rotation

Rotation tool, 87
rulers, 111

S
saves

armature, 406

http://peachpit.com
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assets, 20
Assets panel, 113, 406
file, 14
movie, 50
unsaved changes, 50
workspace, 16–17

Scalable Vector Graphics (SVG), 
112

scale changes, 128–130, 138, 178
Scale Size With Symbol Instance, 

94
scaling, 48–50
Script window, 436, 440
“scrubbing,” 28, 158, 161, 308, 358
Selection tool

to bend motion paths, 
281–282

to edit motion paths, 148
editing curves with, 78–79
Essentials workspace, 38
how to use, 59–61, 117
to orient objects, 151

selections, 279–280
shadow effects, 142, 224–227
shape hints, 340–345
shape tweening

adding to mask layers, 
352–355

adding tweens, 337–338
animation with, 335
applying, 339–340
applying tween, 339–340
begin/end keyframes, 345
broken tweens, 346
color animation via, 363
creating, 337–338
deforming contours with, 333
easing, 346–347
onion skinning, 356–359
pacing changes, 345–346
review of, 369
shape hints, 340–345
variable-width, 367

shapes
animating, 335
Blend types, 340

creating, 56–59
editing, 61–65
fills of, 360–365
inverse kinematics with, 

392–397
masks as revealing, 352
smoothing, 74
transparency of, 99

sharing work, 111–112
Shift key, 58
“Shop now” button, 445–448
single bitmaps, 112
single joints, 250–253
size

of frames, adjusting, 193
rendering speed, 112

skew changes, 178
slow-motion videography, 133
smoothing, 36, 74
Snap to Guides, 111
Snap To Objects option, 146, 147
social media exports, 47
soft bones, 240–244, 243–244
sounds, 186
Span Based Selection, 279–280
special effects, 140
speech, simulating, 185–197
speech balloons, 108–109
speed

ease, 297
joint, 391

Spring feature, 397
stacks, 36, 37, 381–382
Stage, the

attributes on, 33
color effects in, 44
conversion to symbols on, 

89–90
in Essentials workspace, 15
how to use, 18–19
imports to, 21
layout in, 9
modifying, 48–50
positioning objects on, 34–36, 

111
Properties, 18–19

review of, 51
rotating, 87

static text, 103
stopping animations, 451–453
straight paths, 80
strength values, 398
strokes

brushes, 71
changing, 65
default setting, 58
defined, 55
masks and, 348
motion guides as, 145
selecting, 60–61
sizing, 65
variable-width, 65–69, 367

Subselection tool
to bend motion paths, 

281–282
to edit motion paths, 148
editing curves with, 78–79
how to use, 59, 117

supported features, 11
Swap Symbol, 182
swatches, 100
symbols

breaking apart instances, 96
creating, 89–90
defined, 117
duplicating, 93
editing in place, 94–95
editing Library symbols, 92–94
function of, 87
graphic, 185–197
Library storage, 19
managing instances, 90–96
swapping, 426–427
types of, 88–89
See also instances, symbol

system requirements, 3

T
tagged swatches, 100
Test Movie, 46, 156
text

adding captions, 325–327
animating reveal of, 363–365
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creating/editing, 103–109
3D titles, 158–159

Text tool, 103–105
Time Scrub tool, 128, 161
timeline

animation looping in, 156
graphic symbols in, 185
interactive navigation, 431
motion tween, 286
of movie clip symbols, 152
nested animations in, 156
playback controls, 127–128
pose editing on, 391
previews on, 161
rig mapping in, 414
stopping animations, 451–453, 

457
stopping the, 437–440

Timeline panel
appearance changes, 22–23
in Essentials workspace, 15
how to use, 21–29
onion skinning in, 356
organization via, 9

timing changes, 130–135
titles, adding, 158–159
Toolbar, 38
Tools panel

customization, 38
displaying, 38
in Essentials workspace, 15
how to use, 38–41

traditional masks, 352
training centers, Adobe, 6
transformations

global vs. local, 159
removing, 150
transformation point, 62, 

380–381, 401, 404
transition animations, 449–451
transparency

animating, 135–137
controls, 99–100
imports and retaining, 122
instance, 117
mask, 348

tutorials, 5
tween, defined, 121
tweens. See classic tweens

U
Uncompressed Document, 14
undoing steps, 45
Up keyframe, 425
user interface, 2, 14

V
variable-width strokes, 367
vector art

rendering speed, 112
rigs inside, 204, 232

Velocity, 72, 73
visemes, 186
VR 360, 12, 420, 438
VR documents, 420, 438, 444
VR Panorama Animate, 12,  

420, 438

W
Walt Disney Studios, 317
Warp Options, 215, 217, 238, 253, 

268
warp options, 239
warped assets

added to mask layer, 352–355
converting vectors to, 

255–256
editing, 228–232
envelope deformations, 266, 

267
organizing, 227–228
puppet pins, 2

Warped Bitmap, 207
Web Edition, iii, 4
web fonts, 105–108, 117
web tutorials, 5
WebGL glTF, 12, 420, 438, 444
Width, 49, 65–69, 117
Windows installation, 3
wizard, Actions panel, 437–444
workflow shortcuts, 156
workspace, 14–17

X
X (Twitter), Quick Share to, 

46–48

Z
z-depths, 317, 320–322, 323, 327
zoom levels

Camera tool for, 302
Motion Editor, 288
zoom-in animation, 312–313, 

314–316
zoom-out animation, 308–310
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